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BASICS 

File Handling Open File -- File/Open, click File, click Open. (or Control or Shift click files to open 
multiple files.) 

Close File – File/Close 

New File – File/New/Blank Workbook/Create 

Open Recent File – File/Recent, click file 

Switch to another Open File – View/ Windows group, click Switch Windows button, 
click file. 

Save File – File/Save As, enter name, click Save. It normally saves as .xlsx  

(To save file under different version of Excel, select a file type in the File/Save As 
dialogue box (e.g. Excel 97-2003 Workbook – which is .xls).  

Save Changes to File – Click the Save button on the File menu or click the Save 
button on the Quick Access Toolbar. (Or simply use Control S.) 

Arrange All Files in One Window – View/ Window group, click Arrange All icon, 
then (e.g. Cascade), OK. 

Create, Use Template  
To create a template open a file that will be the basis of a template. 
Select  File/Save As. Save  the file as a Template type (xltx), keeping or altering the 
name. Close the template.  
To use the template select File, New, select Personal, and double click on the 
template. After it opens modify it as desired and resave as a regular xlsx file.   
 
 

Add Commands to 
Quick Access Toolbar 

Click down arrow on right side of Quick Access toolbar, and select an entry (e.g. 
Print Preview), or click More commands to add there. E.g. you can select amongst 
Popular Commands, or click down arrow next to Popular Commands, and select a 
Tab, such as Home to see all choices available there. Once a command is selected 
on the left, click Add in the middle to add to right. You can also move items up and 
down on right. Click OK when done. 

Another method to begin: File/Options/ click Quick Access Toolbar.  

Navigating a 
Worksheet 

-To Move Amongst Cells, use Enter key to go down, Shift-enter to go up; Arrow 
keys (to go up and down, left and right), Tab key to go right, Shift Tab to go left.  

-To Go Down a Screen, hit PgDn key. To Go Up a Screen, hit PgUp key.  

-To Go Right a Screen, hit Alt PgDn key. To Go Left a Screen, hit Alt PgUp key.  

-To Go to End of Existing Data, hit Control-End. To Go to Beginning of Sheet (cell 
A1), hit Control-Home. 

-To go to end of column of entered cells, click first entered cell in column. then 
Control-Shift-Down Arrow. Control-Shift-Up Arrow goes  to first entered cell of 
column.  
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To Go To Beginning of Row, Control-left arrow. Control-right arrow to end of cells. 

Scrolling. You can also scroll to move up and down and left and right longer 
distance. Clicking after scroll box, moves you one screen in that direction. 

Working with Cells Enter Data into Cell, click in cell and type. Hit Enter key. Text aligns to the left; 
numbers to the right. Combo numbers and letters (eg a100) to left. 

Edit a Cell – Double click cell, click to change insertion point, or highlight text, make 
necessary changes, and then hit Enter key. You can also click in cell, and change its 
content near the top of the screen in the Formula bar. 

Select Cells – Click cell and drag across other cells. Or click first cell, hold down Shift 
and click last cell. To select discontiguous group click first cell(s), hold down Control 
key and click and drag across second range of cells. 

Move Cells -- Select range of cells, click and drag on cell border and release at 
another cell location. Or select range of cells, Home/Clipboard group, click Cut; then 
click destination cell, in Home/Clipboard group, click Paste. 

Copy (to Adjacent) Cells -- Select cell or range of cells, click Autofill dot in lower 
right corner, and drag down or across. 

Copy (to Non-Adjacent) Cells -- Select range of cells, hold down Control key, click 
and drag the cell border and release in another cell location. Or select cell or  range 
of cells, right click, select Copy, click in desired destination cell, right click, and 
select Paste, and click first option/icon. Or  

Remove Content from Cells – -- Highlight cells, on Home tab in Editing area, click 
Clear and then Clear Contents. Selecting cells and hitting the Delete key does the 
same. 

Remove Formatting of Cells -- Highlight cells, on Home tab in Editing area, click 
Clear and then Clear Formats. 

Remove All from Cells – -- Highlight cells, on Home tab in Editing area, click Clear 
and then Clear All. Note!  

Insert Cells that Shifts Data – To insert blank cells, select desired existing cells, right 
click, Insert …, make choice (e.g. shift cells down), OK. 

Delete Cells that Shifts Data –To delete cells with impact on other cells, highlight 
cells, right click, click Delete, make a selection from dialogue box (e.g. Shift cells up), 
and click OK. (Normally formulas in related cells will readjust in the sheet.) 

Copy Cells(s) Formatting -- Select cells(s) with formatting, in Home/Clipboard area, 
click Format Painter icon, and then click and drag across range of cells to format. 
(Double clicking Format Painter keeps it on to do across multiple ranges.) 

Columns & Rows COLUMNS: 

Select Column(s) – Click column heading. For many columns, click column heading 
and drag left or right. You can also click the column header, hold down Shift key, 
and click another column header. To select non-adjacent columns, click first column 
heading, hold down Control key and click another column(s). 

Insert Column(s) – Select one or more columns, right click, and select Insert.   
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Hide Column(s) – Select one or more columns, right click, and select Hide.   

Unhide Columns – Drag across missing columns area, right click and select Unhide. 

Widen Column(s) – Click in between column headings, four headed arrow appears, 
click and drag left or right. Or select one or more columns, right click, select Column 
Width, enter a value (e.g. 12), and click OK. Also, double click between column 
headings to make the column the width of the widest entry. 

ROWS: 
Select Row(s) – Click row heading on left. For many rows, click row heading and 
drag up or down. You can also click the row header, hold down Shift key, and click 
another row header. To select discontiguous rows, click first row heading, hold 
down Control key and click another row(s).  

Insert Row(s) – Select one or more rows, right click, and select Insert.   

Hide Row(s) – Select one or more rows, right click, and select Hide.  

Unhide Rows – Drag across missing rows area, right click and select Unhide.  

Change Row(s) Height – Click in between selected row numbers on left, four 
headed arrow appears, click and drag up or down. Or select one or more rows, right 
click, select Row Height, enter a value (e.g. 16), and click OK. Also double click 
between rows to make the row the height of the tallest entry in the row. 

Worksheets 
Select Sheet – Click a sheet at the bottom left of screen. 

Rename Sheet – Double click sheet, type in name and hit Enter 

Create New Sheet – Click Insert worksheet icon to right of existing sheets. 

Insert New Sheet Before Current Sheet – Click on a sheet, then right click and 
select Insert, click Worksheet and OK. 

Move Sheet – Click and hold mouse down on sheet name, and drag left or right to 
new location. 

Delete Sheet – Right click a sheet and click Delete. 

Select Multiple Sheets – Click on first sheet and either hold down Shift or Control 
key and click another sheet. 

Change Number of Default Sheets – File/ Options/ select General on left, in include 
this many sheets area, enter number of sheets desired, OK. 

Change Color of Background of Sheet – Right click sheet, move mouse over Tab 
Color, and click desired color. Click on another sheet to see. 

Zoom In, Out Zoom In, Out -- Click the Zoom In or Out button in lower right corner one or more 
times. Or View/Zoom Group, Zoom button, select percentage, OK 

Appearance 
Formatting 

Change to Bold, Italic, Font, Font Size, Text Color, Background Color, Borders, etc. 
– Highlight cells (or columns, rows), and then Home tab/ Font group, make 
appropriate selection; or select cells, right click, and select appropriate item from 
pop-up.  

Change Alignment – Highlight cells (or columns, rows), and then Home tab/ 
Alignment group, make appropriate selection from left, center, right alignment; 
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top, middle, bottom alignment; special orientation (e.g. counterclockwise). (Or – in 
most cases - right click cells and select appropriate choice from the pop-up that 
appears at the top.) 

Wrap Text – Select a cell that has (e.g. overflowing) text in it, then select Home tab/ 
Alignment group, click Wrap Text. If cells have wrapped text, you can unwrap by 
clicking cell and clicking Wrap Text again. 

Center and Merge – Select cell(s) and drag to select several empty cells, then Home 
tab/ Alignment group, select click Merge and Center, and select appropriate item. 
Merge and Center merges the cells and the text is in the middle; Merge Across 
merges the cells and puts the text from left to right. Merge Cells just merges (e.g. 
empty) cells into one cell. Unmerge Cells negates any cells that have used the 
Merge and Center command. 

Indent Text - To indent text in cell, select cell, click the Indent button in 
Home/Alignment. 

One-Stop Cell 
Formatting 

For many of the above, plus more advanced formatting, right click cell(s), click 
Format cells, and make choices in the dialogue box.  

Cell Styles Styles – Select range of cells, columns, rows, then Home/ Styles group, click Cell 
Styles, and click a choice. (To create a new style, select a formatted range of cells, 
then Home, Style Group, Cell Styles, New Cell Style, rename style, and click Format 
to add additional formatting, or just click OK to keep formatting of the originally 
selected ranges of cells. The new style will now appear in Cell Styles at the top. To 
modify a style, Home/ Styles group, click Cell Styles, right click a choice, click 
Modify, click Format, etc.) 

Number and Date 
Formatting 

Simple Number Formats – Select data, Home/ in Number group, select a style from 
the drop-down list (e.g. Currency). Use the icons below the drop-down list to 
increase or decrease the number of decimals.  

More Complex Numbers Formats – Highlight cells (or columns, rows), and then 
Home tab/ Font dialogue launcher which opens Format Cells dialogue box, click 
Number tab, in Category list, click Currency or Number or Accounting, select a Type, 
OK.  Select Percentage as Category to change a decimal number into a percentage, 
and General to change it back to a Decimal.  

You can also similarly apply Short Date or Long Date formats to cells with dates in 
them. 

One-Stop Cell 
Formatting 

For many of the above, plus more advanced formatting, (right click cell(s), click 
Format Cells, and make choices in the dialogue box from among the categories of 
Number, Alignment, Font, Border, Fill, Protection.   

Conditional 
Formatting 

Apply Conditional Formats to a Range – Highlight cells (e.g. in a list) and in Home / 
Styles group, click Conditional Formatting, and select- 
-Highlight Cell Rules and enter the value and the color info (e.g. Less than 100000 
make it red fill) or Top/Bottom rules (e.g. change Top 10% to 25% with Green fill) or 
Text that Contains to colorize text that meets a certain condition, such those that say 
“Great.”  
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- You can also use Data Bars, Color Scales, or Icon Sets to see bars, color accentuation 
and icon info related to the data. 

-Clear the rules by highlighting cells and clicking Clear Rules. 

Quick Analysis -- You can also highlight cells in a listing and then click the Quick 
Analysis icon that appears in lower right of the selected range, and select a 
conditional formatting option. 

Modify a Conditional Formatting Rule – Highlight cells (e.g. in a list) and in Home / 
Styles group, click Conditional Formatting, and click Manage Rules to work with 
existing custom rules created. Click Edit Rules.  

Create New Conditional Formatting Rule – (e.g. make cells over 100000 red 
background) Highlight cells (e.g. in a list) and in Home / Styles group, click 
Conditional Formatting, and click New Rule. Eg in Format Style drop-down menu 
select Data Bar, in the minimum section in the Type drop down menu select Number, 
in the Value field type 100000, ensure Automatic is selected in Maximum section. In 
Bar Appearance section, select Color drop down arrow and then from Standard 
Colors section of the Color gallery select Red, OK. All cells selected over 100000 have 
red background.  

(Tip: Filter by Color. Click in the column in an Excel List that has conditional 
formatting using color, click on the Filter button on the Data tab, then click the down 
arrow and select Filter by Color, and select the color you want to filter by.)  

Named Ranges (of 
Cells) 

Name a Range of Cells – Highlight cells, enter name of range in Name box to the left 
of the formula bar at the top left of the page. (You can also do it with Formula/ 
Defined Names group, click Define Name, and Define Name.) 

Go to a Named Range in Sheet – Click down arrow to the left of the formula bar in 
the upper left of the age and select an existing named range. 

Edit a Named Range – Formula/ Defined Names group, click Name Manager, click 
the existing named range, and modify the cell address to indicate new range (Note: 
the first part is the sheet name, followed by the cell range), and click Close. 

Named Range in Formula -- E.g. type =Sum(Sales).  Or type =Sum( and as you type 
you will see the existing named range names, double click on the one you want, and 
then hit Enter key. Or type =sum(, then go Formulas/ Define Name and select Use in 
Formula, select the name Range, and then hit Enter.  

Special Named Range Use in Formula -- Also =@MoSales-@MoProfits, where the 
formula would know the cells in that part of the range it is referring to (like a1-b1), 
and then when copy/pasted down or across it would know the cells it refers to like 
a2-b2, etc.) (see Excel365 Sample file)  

Find, Replace Find Data – Home/ Editing group, click Find and Select, click Find, in Find What field 
enter text to find, click Find Next, etc. (To find special text, such as italicized, – 
Home/ Editing group, click Find and Select, click Find, under Find What field click 
Options, click Format, click Font tab, select italics, OK, Find Next, etc.) 
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Find and Replace -- Home/ Editing group, click Find and Select, click Replace, in Find 
What field enter text to find, click in Replace field type in replace text, click Find 
Next, click Replace, or Replace All.  

Go To - Home/ Editing group, click Find and Select, and click Go To. In the dialogue 
box enter the cell to go to or the previously created Named Range, and click OK. Or 
to begin simply select Control G.  

Go To Special – Selects entire groups of cells in sheet based on condition you select. 
Home/ Editing group, click Find and Select, click Go To Special. Click Constants to see 
all non-formula cells in sheet. Formulas to see only Formulas in sheet. Etc.  (You can 
also see the contents of all formulas by selecting Formulas/Show Formulas.)  

Highlight Found Using Conditional Formatting – If you want to highlight all instances 
of found content, rather than see one instance at a time, you can use Conditional 
Formatting to show it. (see Conditional Formatting topic) 

Quick Data Entry Auto Numbering with Patterns - E.g. type 1 in a cell, hit enter, and 2 in next cell. 
Then highlight both cells, click Autofill dot in lower right corner of combined 
selection, and drag down. The numbers will be added in a progression (3, 4, 5, etc.) 
Try the same with one cell 10, enter, 20, highlight, and drag the range. 

Smart Date Autofill - Type Jan or January, and then drag Autofill down or across, and 
it will add Feb or February, Mar or March, etc. Or type Jan 2010, drag, and it will 
autodate. Or type Monday and drag, and it will autodate weekdays. Or type Qtr1 and 
drag to extend to other three quarters and then go back to Qtr1, etc.  

Miscellaneous Data 
Handling 

To Copy Resulting Values based on Formula Behind It, select cells with formulas in 
it, right click and select Copy, then go to where you want to paste, right click and 
select Paste Special, Values. (You can highlight paste the values back into the 
original cells.) 

To Separate Out Text into Multiple Columns, highlight the cells of data (e.g. first 
and last name in a single cell), and on the Data tab in the Data Tools area click Text 
to Columns. Now follow through on the wizard. Eg if you have a first name, space, 
and last name in the same cell, leave as Delimited, change the separator to “Space,” 
click Finish. (In other case, you might have commas, tabs, etc. as the separator.) 

To Remove Duplicates, highlight a range of cells, and on Data tab in Data Tools area 
click Remove Duplicates. Indicate the columns  which you want to eliminate  
duplicates. Then click OK. The first entry remains, but the duplicates are  eliminated. 
In fact, what happens is  that the row the duplicate(s) is/are  in is removed.  

To Transpose Data, (eg from vertical to horizontal) start by selecting a range of cells 
in a column, then right click and select Copy. Click on a new location in your sheet, 
then right click, click Paste Special, then click Transpose check box, and click OK. 
Excel will transpose the data in the range of cells in the column to a range of cells in 
the current row. (Hit Escape key to stop the “marching ants” in the original data 
range.) 

Import Text File Data – Open the to-be- imported file and examine it. Eg it might 
have comma-separated text. Then close it. Then click empty cell, then in Data/Get 
and Transform Data area, select Get External Data, From Text, select the file, and 
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click Import. Then (e.g.)  leave as Delimited at top of page, (eg as Comma) or switch 
to different delimiter, and click Load. 

Freeze Panes, Split 
Window 

Freeze Column Headings -- Select the column to the right of the column you want 
to freeze, and on View tab, in Window area, select Freeze Panes, Freeze Panes.  
Now scroll to right to see the effect. 

Freeze Row Headings – Select the entire row under the row you want to freeze, and 
on View tab, in Window area, select Freeze Panes, Freeze Panes.  Now scroll up or 
down to see the effect.  

Freeze row and column together -- Click a cell that is at the intersection of where 
you want the double freeze, and then on View tab, in Window area, select Freeze 
Panes, Freeze Panes.  Now scroll up or down, or left or right relative to that cell to 
see the effect. 

Unfreeze panes -- Click in any cell and on the View tab, in Window area, select 
Unfreeze Panes.   

Split Screen into Panels -- Click in any cell where you want the screen to be split in 4 
parts, and on the View tab, in Window area, click Split. Now click at the intersection 
point, and drag to desired splits for the four panes; or move the horizontal and 
vertical splits where you want. You can also remove one of the splits by dragging it 
to an edge.  If you double click the 4-point intersection, the split will be removed. 

FORMULAS/FUNCTIONS 

Basic Formulas Simple formulas:  E.g. type in cell =a1*b1; or =(a4/b5)*6 

Click through approach: You can also click your way through. Eg, type =, the click in 
cell a1, then type in *, then click in cell b1, and hit Enter key.  

Copy formula to adjacent cells: Once you have a cell with a formula, you can copy 
the formula relative across or down to other cells by clicking on and dragging tiny 
box in lower right corner of the original cell. Or you can select original cell plus 
additional cells to copy to, and hit Control D. 

Absolute reference: When you copy down a cell to other cells with an absolute 
reference ($ sign), the formula in other cells will still reference the same cell as the 
first cell.  
E.g. type in cell   =$a$1*b1. When you copy this formula to other cells, it will still 
reference cell a1. You can also highlight the part of the formula you want to make 
absolute and hit F4, which will put $ signs around it, and hit Enter.  

Basic Functions Basic Functions are Sum, Average, Min, Max, Count, Counta 

(method 1) E.g. type =sum(, drag through the desired range (e.g. a1:a18), and hit 
Enter. 

(method 2) Type =sum, double click the sum function from the pop-up, drag to 
highlight desired cells area, and hit Enter.  

(method 3) Click in cell, click Formula tab, click AutoSum, and then Sum; adjust the 
range as necessary, and hit Enter. 
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(method 4 - advanced) Click in cell, click Formula tab, click Insert Function, click 
Sum, accept the range of cells selected (if appropriate), and click OK. 

Other useful functions are: average (sum of values divided by the quantity of 
values), min (lowest value), max (highest value), count (counts # of cells with 
numbers in it), counta (counts # of cells containing text or numbers) The way you do 
this is the same as when building a Sum function.   

TIP: create a sum function and then change the word sum in the edit bar to one of 
the other functions (like average min, max, count, etc.). 

There is also median (the middle number), mode (most frequently occurring 
number), stdeva (variation from the average/mean). 

There is also subtotal function, which is helpful when lists are filtered, and it 
subtotals based on what remains as a result of the filter. Eg =subtotal(9,g4:g10) The 
9 indicates a Sum of the range; while other number 1-8 indicate as follows: Average 
(1); Count (2), Counta (3), Max (4), Min (5), and others. The 100 examples are the 
same, except they don’t include hidden rows. 

Copy/Paste Formula -- Once you have a formula you can click and drag the AutoFill 
dot in lower right corner of cells to copy to adjacent cells in a relative way. (You can 
also use the right click Copy, and then right click Paste approach for non-adjacent 
cells to copy to.) 

Enter Function using Named Range: Create a named range (see explanation in this 
document). Then type =sum(, then either type in the name of the named range if 
you know it, or enter the first few letters of the Named Range and you will see it in 
the pop-up list of functions, click on it, and hit Enter. Or type =sum(, then go to 
Formula/Defined Names, and select Use in Formula, select the named range 
desired, and click Ok. 

Autocalculate Area – When you highlight a range of values, you see its sum in the 
lower right of the screen. To add more functions there, right click the area and 
select others (e.g. Average).   

Advanced Method of Inserting and Building Functions – On Formula tab click Insert 
Function on the left, type in the name of the function in the search box (eg If), and 
click Go.  Then click on desired function that appears (eg If), and click OK. Now enter 
(by typing, dragging ranges in sheet, et al) the proper information into each 
argument. 

Formula Link to Cell 
in Another Sheet  

-Simple Single Cell Link -- Click in a cell, type “=”, switch to another sheet, and click 
on the desired cell. Then enter a “+”, then click on other  sheet and click on cell and 
hit Enter key. Eg formula across sheets in same file could look like 
='Qtr1'!I2+'Qtr2'!H3. The ! indicates the sheet name. 

-Sum Function Link -- Type “=sum(”, switch to the other sheet, drag across the 
range of cells and hit enter. Eg =SUM('Qtr1'!K4:K7)  

-3D References -- To sum up the contents of the same cell across sheets: eg Here’s 
how: 
1. type =sum( 
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2. click first sheet (e.g. qtr1), hold down Shift key and select last desired sheet (e.g. 
qtr2) 
3. then click in desired cell (e.g. c4) in the current sheet, and hit enter. The formula 
then looks like this: =sum(‘qtr1:qtr2’!e4) 

Link to Sheet(s) in Other Files -- You can do the three features above to sheet(s) in 
other files as well. Just activate the necessary file/workbook and corresponding 
sheet, and it will put the file/workname in the formula. The file name in the formula 
will appear in brackets.  

Edit Links -- To see, adjust, redirect, or break links to another file/workbook, select 
Data/ Queries & Connections group, click Edit Links.    

If Functions If – In a cell enter =if(f4>30000, "Great","Good") meaning if f40 is greater than 
3000, then enter the text “Great” in the current cell, otherwise enter the text 
“Good.” [See another example in Excel365 Sample file] 

Another example: In a cell enter =if(a3>=100,b3, c3) meaning if a3 is greater than 
100, then enter the contents of b3 in the current cell; if not, enter the contents of 
c3. [See example in Excel365 Sample file] 

A third example: =if(f3>100,sum(f3:f7),f3*10) meaning if f3 is greater than 100, 
then sum up the range f3 to f6; otherwise multiply the contents of f3*10. (See 
example in Excel 365 Sample file) 

If (with AND) -- This version of If requires two things to be true in the first 
argument. Eg =if(And(k3>3000,l3>2000),"Bonus","No Bonus") says that if k3 is 
greater than 3000 AND l3 is greater than 2000, then put in Bonus; otherwise put in 
No Bonus. [See example in Excel365 Sample file] 

If (with OR) -- This indicates only one of the two things in the first arguments needs 
to be true. Eg =if(Or(k3>3000,l3>2000),"Bonus","No Bonus")   says that if k3 is 
greater than 3000 OR l3 is greater than 2000, then put in Bonus; otherwise put in 
No Bonus.  

Nested/Branching If: Eg  =if(b2<2000,b2*0.05,if(b2<5000,b2*0.07,b2*0.09)) This 
says if b2 is less than 2000, then put in the contents of b2 times .05; otherwise grab 
the result from an If statement that if b2 is less than 5000, then multiply b2 times 
.07, otherwise put in b2 times .09) [See another example in Excel365 Sample file]  

Ifs – Eg  =IFS(B4="Good", C14,B4="Bad", d14)  I.e. If b4 is equal to Good, then put in 
contents of c15. However, if b4 is equal to Bad, then put in the contents of d14. 

SumIf (and AverageIf 
and CountIf) 

SumIf -- This function enables the user to enter a criteria, which looks for matching 
entries in a range of cells, and then enables the summing up of the values in a 
corresponding range. E.g. =sumif(g13:g19,j13,h13:h19)means that the user 
indicates the first range of cells g13:g19, which say has entries of invoice due days 
like 30, 45, and 60.  Then based on the value the user enters into cell j3 (say 45), it 
looks at the range of values of Sales in h13:h19 (where the g13:g19 entries are equal 
to 45), and sums them up. [See another example in Excel365 Sample file] You can do 
the same essential thing with the AverageIf function. (Note: CountIf has a 
somewhat different logic. Eg =countif(g13:g19,j13)  

SumIfs – This functions goes beyond sumIf, and uses 2 or more criteria for 
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determining the outcome. In cell q17, enter =sumifs(q13:q16,p13:p16,"south", 
o13:o16,">5/1/2019") , which outputs total 560 units in q17. (See example in 
Excel365 Sample file) You can do the same essential thing with the AverageIfs 
function.   

To see webpages with more examples:   
SUMIF function - Office Support (microsoft.com) 
SUMIFS function - Office Support (microsoft.com) 
COUNTIF function - Office Support (microsoft.com) 
COUNTIFS function - Office Support (microsoft.com) 

Lookup Functions With the VLookup  function you enter a value in a cell and it looks up a 
corresponding value from a column of your choice. 

[See example in Excel365 Sample file; on LookupEtc tab]   

Click in cell E4 and type. =VLOOKUP(D4,A4:C11,2,FALSE)  

This will use a value entered in D4 (in this case 1004), look for it in the range A4:C11, 
and specifically look in the 2nd column of that range for the matching content, and 
pull up the result  (Yellow).  If an entry isn’t found, then you get the error message 
#N/A.  

Fill Down Issue -- You could copy that formula down, however in its present form, he 
formula will not copy correctly. That is because the second argument (A4:C11) will 
shift down in the copies. Therefore you have to go back and make that part of the 
original formula absolute. To do that you put dollar signs around that part  of the 
formula (in E4), [eg highlite A4:C11 and hit the F4 or Fn-F4 key] and enter it. It 
should now read =VLOOKUP(D4,$A$4:$C$11,2,FALSE). Now when you fill down the 
formulas in the other cells will be accurate. 

Notes:  

-Vlookup can use a range (second argument) located in another sheet or another 
sheet in another file.  

-Also the second argument (the range) can be a named range instead of a range of 
cells, provided you have previously created a named range for the area. [See 
example in Excel365 Sample file; on LookupEtc tab]  Eg. 
=VLOOKUP(N15,emailaddress,2,FALSE) 

 

HLookup works in a similar way to VLookup, but works where the headers are in 
Rows on the left side, instead of for columns at the top.  

[See example in Excel365 Sample file; on LookupEtc tab] Here is an example 
formula: =HLOOKUP(H6,H2:K4,2,FALSE). 

Step by Step: In cell H7 type =HLOOKUP(, then type in H6, comma, then highlite the 
range H2 to K4, comma, enter a 2 [indicating the second row], comma, type in 
FALSE, and hit the Enter key.  Now change cell H6 to a different PLANET (eg Mars), 
and see the result in H7. 

 

https://support.microsoft.com/en-us/office/sumif-function-169b8c99-c05c-4483-a712-1697a653039b
https://support.microsoft.com/en-us/office/sumifs-function-c9e748f5-7ea7-455d-9406-611cebce642b
https://support.microsoft.com/en-us/office/countif-function-e0de10c6-f885-4e71-abb4-1f464816df34
https://support.microsoft.com/en-us/office/countifs-function-dda3dc6e-f74e-4aee-88bc-aa8c2a866842
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XLookup will likely eventually replace VLookup and HLookup both, being able to do 
either within itself. There are other advantages to XLookup as well, such as not 
having to put in True/False argument at the end, allowing first argument to be 
anywhere, not just to the left of the formula, the ability to return multiple items, 
replaces Index/Match function combo, and others.  

(Note: VLookup doesn’t work on Excel 2016 or earlier)  

(See following example of XLookup in Excel365 Sample file)  

Here is an example formula: =VLOOKUP(T15,Q15:Q21,S15:S21) Step by Step: in cell 
U15 enter =XLOOKUP(, then type in T15, comma, highlite the range Q15 to Q21, 
comma, highlite the range S15 through S21, and hit Enter key. Now change cell T15 
to a different country (eg Brazil), and see the result in U15. 

See other XLookup examples here: https://support.microsoft.com/en-

us/office/xlookup-function-b7fd680e-6d10-43e6-84f9-88eae8bf5929 

Index, Match 
Functions 

Index and Match are location-oriented functions, in terms of the rows and columns.  

Index function pulls up a result based on its locations within a grid of data. Eg it pulls 
up the value of the cell that lies at the intersection of a  particular row or column. 
Example: =index(a15:d18,1,2) In the range of cells a15 to d18 it pulls up the value of 
the cell that is at the intersection of row 1 and column 2. Eg returns “Apple”.  

(See example in Excel365 Sample file) 

You could use this instead of eg a VLookup when the list has say hundreds or 
thousands of records, and you only need to lookup data that resides say in the first 
and last column, not having to pull up info from other columns. (If there are so many 
columns with so much data in it, then recalculations may take a long time with 
VLookup, but faster with Index function (or the Match function). 

Here is a fuller explanation with examples: 

Match function finds the location of a cell matching an input e.g. =match(25,a22:a24, 
0)  I.e. for the amount 25, it finds its location in a range of a12 to a 24. In this case 25 
is in the second row of the range, and therefore comes up with a 2 as the result. Other 
examples 

 

Date, Time Functions -To get the current date and time (that updates when reopened), type =now() 

-To get the current date (that updates when reopened), type =today() 

-To get the year of a date, use the YEAR function. =Year(a2), where A2 has a date 
like 3/15/2015   

-Likewise, use the =Month(a2) and =Day(a2) functions to get the month # (e.g. 8), 
and day of the month # (e.g. 14) respectively. 
To add or Subtract days to/from a date, enter a date e.g. 4/1/15 into a cell, say A4. 
Then in next cell enter =a4+50. Excel shows the date 50 days later (5/21/15). 

You can also subtract one date from another to get the difference in days, (or add, 
multiply, or divide). Eg in cell create formula that subtracts 2/1/17 in b3 from 

https://support.microsoft.com/en-us/office/xlookup-function-b7fd680e-6d10-43e6-84f9-88eae8bf5929
https://support.microsoft.com/en-us/office/xlookup-function-b7fd680e-6d10-43e6-84f9-88eae8bf5929
https://www.techonthenet.com/excel/formulas/index_function.php
https://exceljet.net/excel-functions/excel-match-function
https://exceljet.net/excel-functions/excel-match-function
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2/10/17 in b4. (=b4-b3). Result shows (e.g. 9). (You may then have to change the 
format of that cell to Number.)  

Text-oriented 
Functions 

The TEXT function converts a numeric value to text and lets you specify the display 
formatting by using special format strings.  Eg in a1 enter 23.50, which is a number, 
Then in another cell enter =TEXT(A1,"$0.00")  Excel displays $23.50, but left aligned 
(as text). Other examples using text function:: 
https://support.office.com/en-us/article/TEXT-function-20d5ac4d-7b94-49fd-bb38-93d29371225c 

The Trim function removes leading and trailing spaces from the text in the formula 
=TRIM(" First Quarter Earnings ") results in First Quarter Earnings. Or simpler still 
=Trim(d8) 

(also see the Clean function) 

The Concatenate Function joins two or more text strings into one string. E.g. 
=CONCATENATE(B2, " ", C2) joins three things: the value in cell B2, a space 
character, and the value in cell C2. The result is the name Andreas Hauser.  

Another example: =concatenate(c2,”, “,b2) creates Hauser, Andreas. 

An alternative approach is =d3&E3, which combines abc in d3 and xyx in E3 to 
produce a result of abcxyz. 

 

Left function 
Eg type in cell a2: Columbus Ohio 43228 
Example 1: =left(A2,8) will return “Columbus” (first 8 defined characters).  

However, since the cities can be of varying length this approach is limited. Therefore 
we can use the Left function in tandem with the Search function. First we’ll do 
Search function, then the combination of Left and Search. 

Eg in D2 type =search(" ",A2). That pulls in the number of characters. Now in 
tandem with Left we can grab the current info. Eg type =left(A2,search(" ",A2)-1) 

 
Mid function 

 =mid(A2,10,4) will return “Ohio” (starting at the 10th character it extracts the 4 
next characters) 

 
Right function  

=right(A2,5) will return “43228″ (last 5 defined characters).  

 

Len 

This functions indicates the number of characters in a cell. Eg =Len(a3) returns 
“8”,where the text in A3 is “Salesxyz” 

Len works in tandem with other functions. Eg =Left(a3,Len(a3)-3) returns “Sales”  
This formula determines the number of characters of A3 (say 8 characters), 
subtracts 3 from that length (thus 5 characters), and shows the text from first 5 
characters from the left.   

https://support.office.com/en-us/article/TEXT-function-20d5ac4d-7b94-49fd-bb38-93d29371225c
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Additional Text-related functions overview: 
http://www.excelfunctions.net/Excel-Text-Functions.html 

Categories of 
Functions and Your 
Needs 

-There are various categories of Functions, such as statistical, logical, financial, etc. 
They can be found in the Formula tab. Let’s say you want to know the possibilities of 
using Financial functions. Its best to Google “Financial functions in Excel 2016” to get 
an overview of what each function does, with an example, and an explanation of the 
arguments for each one. That way you can now which of them are appropriate for 
your needs.  

-Also create a new file based on an Excel template in which you have entered a search 
of (eg) “Financial”. A number of templates will appear that contain financial functions. 

Arrays Array formulas are very powerful formulas that enable you to perform calculations 
you can’t do with standard worksheet functions. Use an array formula to do the 
seemingly impossible, such as Count the number of characters in a range of cells; Sum 
numbers that meet certain conditions, such as the lowest values in a range or 
numbers that fall between an upper and lower boundary; Sum every nth value in a 
range of values. 

A good example of an array involves multiplying one column by another. Ordinarily 
you multiply one cell times another cell and get the result in a third cell, and then do 
the same thing for each of the pairing of cells in the two columns. Then you would 
sum up all in another cell at the bottom. That’s a lot of work. With an array, you can 
do this all in one cell. Eg you would type the following in an empty cell 
=SUM(H15:H20*I15:I20) and then instead of hitting Enter, you do Control- Shift-
Enter, resulting in the formula {=SUM(H15:H20*I15:I20)} Note the extra squiggle 
character at the start and end of the formula, indicating it is an array formula. This 
would produce a result such as $30,736.95 (See example in Excel365 Sample file) 

Additional examples 

-Also note that several advanced features – including Data Tables, explained 
elsewhere -  in Excel use an array calculation to create the result.   

PRINTING 

Basics 1. First configure the presentation and margins of the printout as needed 

Setup: Activate Print Preview and Print in Quick Access area. Then click on Print 
Preview button in Quick Access area, and then close the screen that opens. You will 
see the page break lines on the page. 

To change the orientation of the printout, File/ Print/ click the Orientation button, 
and click (e.g.) Landscape Orientation. (You can also change it from Page Layout tab/ 
Page Setup, and click Orientation.) 

To change the margins of the printout, File/Print/ click Normal margins under the 
Settings area, select a margin or click Custom Margins, and set them in the dialogue 
box and OK. 

2. Once you have the desired orientation and margins, select from the following: 

http://www.excelfunctions.net/Excel-Text-Functions.html
https://www.vertex42.com/blog/excel-formulas/array-formula-examples.html
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To print the active sheet(s), File/Print/ select Print Active Sheets under Settings, 
then click Print.  

To print a specific range of pages, File/ Print/ enter the range of pages under 
Settings (e.g. 1 to 4), and then click Print. 

To print a specific range of cells, highlight cells in sheet, File/ Print/ click Print 
Selection under Settings, and then click Print. 

To scale to fit on one page, File/ Print/ at bottom change No Scaling to Fit Sheet on 
One page. 

To scale the printout to a % of size or to a fixed number of pages, make sure No 
Scaling is set in File/Print, then select the Page Layout tab/ Scale to Fit group 
-In Adjust to area enter the % to adjust to (e.g. 80%),  
-or in Fit to area, click the Width arrow, and in list select (e.g.) 1 page; and click the 
Height arrow, and (e.g.) click 2 pages. 

To print the entire workbook, File/ Print/ click Print Entire Workbook in the first 
area under Settings, and then click Print.   

Switch Between 
Views 

You can switch to Page Layout view where you can see the page break areas by 
clicking Page Layout in the lower right corner of the screen. You can zoom in and 
out if necessary using icons in lower right corner of screen. (You can also go back to 
Normal view from there, and you will see the page breaks – dotted lines.)  

Force Page Breaks To force a page break on a sheet, click a row or column header (or cell for multiple 
breaks) where you want the page to break, then select Page Layout/ Page Setup 
group, click Breaks, and then click Insert Page Break. To remove a break, select the 
point of removal, and then Page Layout/ Page Setup group, click Breaks, and then 
click Remove Page Break. 

Set Print Area To force the printing of a designated range on an on-going basis, select a range of 
cells (or multiple ranges using the Control key), then on Page Layout tab/ Page 
setup group, click Print Area, and then click Set Print Area.  If you do a Print Preview 
(e.g. whose icon you can add to and choose from Quick Access toolbar), you will 
see what will print. 

To clear the custom print area, Page Layout/ Page Setup group, click Print Area, 
and then click Clear Print Area.  

Print Titles To print row or column titles on each page, Page Layout/ Page Setup group, click 
Print Titles. In the dialogue box click in either Row to repeat at top or Columns to 
repeat on left, click the corresponding row or column in the sheet, and click OK.  

Print Order To change the order that pages print, Page Layout/ click the Page Setup dialogue 
launcher (lower right corner of group), click Sheet tab, and in the Page Order area, 
select Over, then down, and OK.  

Headers, Footers To insert header content (for each printed age), Insert/ Text group, click Header and 
Footer. You go into the Header and have three areas to enter info -- left, center, 
right. Center is selected.  

To insert text (in header), type into the middle section (such as the name of the 
company).  
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To insert the file name, have insertion point in one of three header sections, Design 
contextual tab / Header and Footer Elements group, click File Name.  
To add the current date, Design contextual tab / Header and Footer Elements 
group, click Current Date.   
To go to the footer (from within header), Design contextual tab / Navigation group, 
Go To Footer.  
To insert page numbers with total pages, in Design contextual tab / Header and 
Footer Elements group click Number of Pages icon.  
To exit the header or footer, click in a cell (out of header or footer), and then View 
tab and then Normal.  

CHARTS AND GRAPHICS 

Charts To create a recommended chart, highlight the headings and data cells from a list or 
table, in the Insert/ Charts area, click Recommended Charts, select one of the 
recommended charts, and click OK. The chart is created in the current sheet.  

To create a desired chart, highlight the headings and data cells from a list or table, 
in the Insert/ Charts area, click the down arrow next to one of the types (e.g. 
Column Chart) and select one of them. 

Note: when you highlight the data, you can select two groupings of headings and 
cells by using the Control Key. E.g. highlight Names and Sales heading and data, hold 
down control and them also select Total Commission heading and data. You will 
thereby create 2 Series (groupings of data that the Chart will plot.) 

To change to a different Quick Layout, click chart, click Quick Layout, and select one 
of the designated layouts. 

To change a chart type, click chart, Design contextual tab / in Type area, click 
Change Chart Type, and choose a chart type.  

To apply a different style to a chart, click chart, Design contextual tab / Chart Styles 
group, click the More button (lower right corner), examine the style types, and click 
a Style. Or click the chart and then click the Chart Style icon to the right of it. 

Automatic sequencing -- If you change the data in the list/table, the chart will 
reflect the changes. 

To move a chart in same sheet, click the chart, and when you see 4-headed arrow, 
drag to desired location. To move chart to another sheet, click Chart, Design/ 
Location group, click Move Chart, click either New Sheet, name the new sheet, and 
click OK; or select an existing sheet from the Object pop-up list. (Cut and Paste also 
works) 

To resize a chart, click lower right corner of chart, and when you see the double 
arrow, click and drag to whatever size desired. 

To add or subtract a chart element, click on the chart and click the “+” icon to the 
right of the chart and check or clear any of the elements. Eg depending on the 
current status of the chart you could select to add an x axis, add a legend, and then 
double click them to change their text.  Advanced Elements Control – Click Chart, 
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click Design tab, click Add Chart Elements, roll over items, and select desired 
change. 

To move the legend, click on it and drag to desired location. 

To change the numbers of an axis, click chart, activate the axis, right click the values 
in the axis, click Format Axis, click Number, change the Bounds range (e.g. 0 to 
1000) and the Major and Minor Units (e.g. 100 and 20). Also, change the format by 
clicking Number and Currency.  

To format parts of a chart, double click an area of the chart and make selections 
from the Format Plot area on the right. Eg double click the background of the chart 
and then click the Fill button on the right and choose gradient fill. 

To print a chart, click on it, File/ click Print. If the chart is on its own sheet, then you 
can just print. If the chart is on the same sheet as the data, then when you do 
File/Print, verify Print Selected Chart button is selected, and then click Print. 

To switch the arrangement of the data, click chart, and select Design tab, and then 
Switch Row/Column. 

To change data range, select Design, Data area, Select Data, and manually reselect 
the data range, Ok. 

To filter the data in the chart, click the chart and then click the Chart filters icon (it 
looks like a funnel) to the right of the chart, and select the desired data desired. Eg if 
you hover over any entry, it will show dimmed in the chart. On the other hand, if 
you click on a box, it will hide that item – e.g. hide an entire series or hide one of the 
entries in a series.  When you click Apply it will execute that filtering on the chart. 

Trendlines – For each series you can have its own Trendline, even multiple 
Trendline of different types. Note that trendlines work best when you have a Date 
field of sorts in the source data area, so a trend into the future can be created. 

To create a Trendline select a data series in the chart, then click “+” to add chart 
element, select Trendline. Now click the Trendline and under Chart Tools tab at top 
of page select Format. Then click Format Selection on the left, and change to the 
Trendline you want on the right. The Trendline Types are explained on page XXX of 
Excel 2016 Level 3 book.  

To extend the Trendline to make a projection, make sure Format Trendline gray 
dialogue box is in view on the right, click Custom under Trendline Name below, type 
Forecast in the box to right, in the Forward box type 5. Try out the various Trendline 
types again. You see it projected out five years.  To create additional trendlines for 
the chart, make sure the Format Trendline gray dialogue box on the right is in view, 
then click Trendline Options at the top of that view, and click the next available 
trendline to be created (e.g. it could be called “Series Sales Trendline 2”), and set its 
properties. 

To create a chart template, right-click the chart, and pick Save as Template, type an 
appropriate name, click Save. To use a saved template, in Insert/ Charts area, click 
Recommended, click All Charts at the top, click Templates folder on left, and select a 
template from My Templates (that you created) to base your new chart on. To apply 
a template to an existing chart, select Chart, in Design tab, click change Chart Type, 
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click Templates folder on left, and select desired template to be applied. To apply a 
template to a new chart, highlight data for chart, click Insert, Recommended Chart, 
click All Charts, click on Templates folder, select chart, OK. 

To create a combo chart, have a list with two different sorts of data, eg Sales and % 
Approved (with headings) highlighted. Then select Insert, click the Chart dialogue 
box launcher (lower corner of all shown chart types), click All Charts at top, click 
Combo at lower left, check the Secondary Axis box (on eg % Approved), and click 
OK. When you click the Chart elements button (the “+” that appears next to upper 
right of chart), you now get choices to modify both chart axis, etc.  

New Charts for Excel 
2016   New! 

Histogram, Pareto, Waterfall, Box and Whisker, Sunburst, Treemap 

Waterfall - Shows the first entry relative to the zero point, then shows the next bar 
relative to the top of the first bar, and the third bar relative to the top of the second 
bar, etc. 

Histogram – Shows the highlite data as bins of data  as columns within a range. Eg 
large column bar for data within range 100-500 because there are many records in 
that range, and a smaller column bar for a second range from 600-100 because 
there are few records in that range. 

New Types explained here  

Sparkline Charts Sparkline show in a single cell a mini chart of the range of cells you want to plot.  

To create a Sparkline chart in a single cell, select a range of data (e.g. G6 to I6), 
Insert/ Sparkline area, click a type (e.g. Line), click the cell(s) or enter the cell 
address/location you want the sparkline chart to appear (e.g. J6) and click OK.  You 
can move the sparkline by dragging its outer edge to a different location. 

To change the style of Sparkline, click cell with sparkline, Design contextual tab/ in 
the Style area, click to select a style.  

To change the type of Sparkline, click cell with sparkline, Design contextual tab/ in 
Type area, click a different type (e.g. Column).  (Win/Loss is for showing negative 
values.) 

Misc. -- You can also make the row taller to see the mini chart better. 

Highlight points -- You can also show the high, low points, and other in the series of 
plotted data.  

To clear a Sparkline, click on cell, Design contextual tab, in Group area, click Clear 
button. Or click in cell, Home tab, Editing, Clear All. 

Graphics Add Simple Shapes - Insert/ Illustrations group, click Shapes button, and click an 
entry (e.g. Oval). Now click and drag to create the shape (e.g. oval). Holding down 
the Control key turns the oval into a circle. (For a Text Box (first choice), click on 
screen and enter text. You can also move the object, click points to resize box, and 
click on edge and add a fill color. 

-To change its shape, Format contextual tab, Shapes Styles gallery, click a style.  -To 
change its background, fill, border width, etc. right click the shape and select an 
entry.  -To make one shape appear behind another, click a shape, and move it on top 
of another shape, Format contextual tab / Arrange group, click Send Backwards.  To 

https://blogs.office.com/en-us/2015/07/02/introducing-new-and-modern-chart-types-now-available-in-office-2016-preview/
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align two shapes together, hold down Control key, click each shape, Format 
contextual tab / Arrange group, click Align button, and then (e.g.) Align Bottom. 
Also, use the Text Box shape to add text within the shape, and format the box and 
text. 

Add Smart Art – Insert/ Illustrations group, click Insert a SmartArt Object icon. Click 
a type on the left (e.g. Hierarchy), and an entry on the right (e.g. Organization 
Chart). You can modify the SmartArt through the Design contextual tab. 

Add Image to Sheet – Insert tab / Illustrations group, click Picture, double click file. 
Adjust handles along the edge (dots) to resize shape. Click on image and drag to the 
desired location. To eliminate the background of image, Format contextual tab / 
Adjust group, remove Background.  

ERROR HANDLING 

Errors in Formula 
Calculations 

#NAME? – the formula has text in it Excel doesn’t recognize (such as =XYZ) 

#VALUE – the formula has the wrong type of data in the argument.  

-- E.g. if your formula includes cells that contain different data types, such as =A1+B1, where A1 
contains the string "Hello" and B1 contains the number 3. 

--E.g. the formula is entered as PRODUCT(3,"Hello") but that function requires numbers as 
arguments, not text. 

#REF! - The formula references a cell that doesn’t exist (e.g. the row for the 
referenced cell has been deleted). 

#DIV/0 – the formula attempts to divide by zero (such as =a12/0) 

Make the necessary adjustment to correct these.   

Formula Error Checking – You can show each error one by one in a sheet by clicking 
in cell A1, Formulas, Formula Auditing, Error Checking, Error Checking. You have an 
option of editing and correcting each one by entering appropriate info, or Ignoring 
an error, etc. 

Overcome Formula 
Related Errors 

Trace Precedence – To see the cells that a cell is referencing, click in the cell, select 
Formula/ Formula Auditing group, and click Trace Precedents. Arrows appear. To 
remove the arrows, click in any cell, select Formula/ Formula Auditing group, and 
click Remove Arrows. 

Trace Dependence – To see the formula that a selected cell is part of, click in the 
cell, select Formula/ Formula Auditing group, click Trace Dependence. Arrows 
appear. To remove the arrows, click in the cell, select Formula/ Formula Auditing 
group, and click Remove Arrows. 

Make any necessary adjustments to have the cells reference the right formulas, or 
the formulas reference the right cells. 

Trace Errors – To see the cause of an error in a formula (See the Errors in 
Calculations section above), click in the cell, select Formula/ Formula Auditing 
group, click Error Checking and Trace Errors. Arrows appear. To remove the arrows, 
click in any cell, select Formula/ Formula Auditing group, and click Remove Arrows. 
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See Values of Parts of Formula – To see the value that makes up each part of the 
formula, click in the cell, select Formula/ Formula Auditing group, and click Evaluate 
Formula. Step through the formula by clicking the Evaluate button to see the value 
that makes up that part of the formula. 

See All Formulas – You can see the formulas in all cells by selecting Formulas tab, 
and then in the Formula Auditing section, select Show Formulas. 

IfError function With IfError function you can show particular message or other content (or nothing) 
when an error message appears in a cell. Eg if a Vlookup produces an “#N/A” result 
because a value doesn’t exist, you can wrap an IfError function around it to replace 
that error with text you want such as “Unavailable.” Here is an example: 

=IFERROR(VLOOKUP(I5,G5:H12,2,FALSE), "Unavailable") 

See Error tab in Excel365 Sample file for this example. 

PROTECTING FILES, FORMULAS, CELLS, ETC. 

Protect Cells (e.g. 
formulas, labels) from 
being changed and 
Protect Sheet  

All cells are locked by default, but protection is off. We want to unlock all cells 
where we want to allow modification, while keeping cells we want to lock (like 
formulas) locked. Then we turn protection on. Here’s the method: 

1. Using the Control key select one or more cells where the user is allowed to enter 
data (i.e. don’t include labels and formulas), right click the cells, click Format Cells, 
click the Protection tab, and deselect the Locked check box. (If you don’t want user 
to see the formulas in the cells, also click the Hidden checkbox.)  

(Tip: To quickly see all non-formulas in a sheet, do Home/ Editing group, click Find 
and Select, click Go To Special, click Constants.) 

2. For this to work, you also have to protect the sheet. You do that with Review/ 
Protect group, and click Protect Sheet. (It’s also advisable for you to be able to 
unprotect the sheet with a password. To do that, in the Password to unprotect 
sheet box, enter a new password, clear the Select locked cells and Select unlocked 
cells check boxes, and then click OK. Reenter the password, and click OK.) Then 
Save. 

Now try out entering data into the sheet. You will only be able to enter into the 
unlocked cells. The user also won’t be able to use many other Excel functions. 

To Unprotect Sheet, Review/ Protect, Unprotect Sheet. 

Allow 
Entering/Editing of 
Cells only with a 
Password  

You can password protect one or more ranges of cells. (Note: this works best when 
all cells are locked to begin with.) 

Highlight a range of cells, Review tab, in Protect area click Allow Edit Ranges, click 
New, give it a title (e.g. Sales entry), type a password, and click OK. Reenter the 
password in Confirm Password dialogue box. The range of selected cells appears. 
Click Protect Sheet. Enter a password to protect the sheet. Click OK. Confirm the 
password. Click OK. Save. Now try editing in any of the cells that were originally 
highlighted. A password will be required. 

To turn this off, click Unprotect Sheet, enter password, OK, then Allow Edit Ranges, 
select the range to remove (e.g. Sales Entry), click Delete. OK. Save.  
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Protect Workbook 
from Being Altered 

--(Warning: Be sure to make a backup of file before doing this!) Activate a 
workbook, File/Info, click the Protect Workbook button, and click Encrypt with 
Password. Enter a new password, click OK, reenter it, and click OK. Close the file, 
save if necessary, and reopen it, where you will need to enter the password.  

To unencrypt you will have to first open the Workbook, enter the password when 
prompted and then click on File/Info, click drop down on Protect Workbook, click on 
Encrypt with Password, remove the password from the box, and click ok. 

Also, to password protect file from being opened without encryption in the first 
place, select File/Save As, Tools, General Options, and then password to open, enter 
the password, etc. 

LIST HANDLING, TABLES  

Overview  A list consists of ranges of data next to each other, as in a phone book, where the 
title of the heading of each column stand out, usually by making italic or bold. The 
list can then be sorted, filtered, subtotaled, etc. A table is a list that has been 
converted, with added features. 

Sort List Single Level Sort -- Click in column to sort, and then click A to Z or Z to A in the Sort 
and Filter area. 

Multi-Level Sort -- Click in a cell in a list. Data tab /Sort and Filter area, click Sort, 
Excel highlights the data below the headings, and opens the sort dialogue box. 
Select the column to sort by. (e.g. by Department). By default, it will be sorted in 
alphabetical order (A to Z). You can reverse that (i.e. Z to A). Click OK to sort (or see 
next). You can add another level that subsorts the first level. You do that by clicking 
the Add level button and then selecting the field to sort by. (E.g. sort by Department 
and subsorts by Employee.) Click OK. 

Filter List  Click in a cell in list. Data tab /Sort and Filter area, and click the Filter icon. An arrow 
appears for each heading in the list. Click the arrow. 

-You can select, deselect among the available entries in lower part of screen. 

-You can also select from among the pre-set Filters, including Text, numbers, and 
Date 

-By Number – For a column with numbers, you can also select one of the Number 
Filters, such as Greater than or equal to, enter a value (e.g. 100000), and click OK. 
You can add additional criteria by using the And (or) Or selections in the 2nd, 3rd, 4th, 
etc. lines. And means it filters items that meet both criteria. Eg is greater than 
50,000 AND less than 100,000. Or means it filters items that meet either of the 
criteria. (Or usually produces more results.) Eg is (either) greater than 100,000 OR 
less than 50,000 

-By Date – For columns with dates, select one of the Date Filters, eg This Quarter. 

-You can also filter by multiple columns at a time. Eg by Sales, as well as by 
commission. 

-TIP! To clear all filtering click the Filter icon to clear all filters, and then click it again 
to bring back the pop-up for each heading.  



 23 

Sum Vs. Subtotal 
Function Below a List 

When you filter data in a List.  a Sum function calculating the results of a column – 
e.g. =sum g4:g10) -- does not adjust, retaining the same result, whereas a Subtotal 
function -- eg =subtotal(9,g4:g10) -- adjusts to the filter. The 9 indicates a Sum of 
the range; while other number 1-8 indicate as follows: Average (1); Count (2), 
Counta (3), Max (4), Min (5), and others. The 100 examples are the same, except 
they don’t include hidden rows. 

Subtotal by Group You can show subtotals per grouping column of a list. Eg show the subtotal of sales 
for each department. (Note that the Subtotal feature only works with a List, not a 
List that has been converted to a Table. 

–(Important!) First sort the list by the heading you will be grouping by (e.g. by Dept) 
as explained earlier.  

-Then click in a cell in the list, Data / Outline group, click Subtotal, and make the 
necessary adjustments in the dialogue box. (E.g. at each change in Dept, use 
function Sum, add subtotal to both Sales and Commission, and then click OK.  

Click the Outline Levels (1, 2, 3) in upper left to see data at that level. At first you are 
at level 3, or the highest level, which is the most detailed. 1 is the least detailed. 
Click “+” and “- “in outline on left to collapse and expand area, as well as the 
outline.  

To remove the subtotals, click in the subtotals, Data / Outline group, click Subtotal, 
and click Remove All. 

Note!: Subtotal system will not work when the list has been converted to a table. 

Data Form You can work with data in a list through an entry form. First add the Forms button 
to Quick Access Toolbar. It is under “Commands Not in Ribbon.” Then click in the 
list, and click the Form button. Now you can enter a new record, delete an existing 
one, edit existing record, enter criteria for a search, move to the net or previous 
record, etc. You can also use the Arrow keys on keyboard to move among the 
records (or scroll). To enter a record hit the enter key. 

Table-based List You can turn a list of data into a table-based list, which can be more convenient 
than an ordinary list as it has a filter button for each field already built in, allowing 
for easy sorting and filtering; and the ability to easily expand the ranges of data that 
makeup Formulas, Functions, and Pivot Tables. 

Turn List into a Table – Click anywhere in a list, and select Insert, Table, accept the 
range of the data for the table, and click OK. 

Give Table a Name – (this is useful for use in multi-table Pivot Tables and for 
switching the data source to a different table.) Highlight all data in table, click 
Design tab, in Table Name area way on the left enter a name (eg Sales). 

Sort, Filter Columns in Table – Click the down arrow for any column heading, and 
select desired entry (for sorting or filtering). To do multi-column sorts, click in table, 
select the Data tab and then click Sort button. 

Add Total Row to Table – Click in cell in table, in the Design contextual tab/ in Table 
Style options group, select Total Row checkbox. 



 24 

Change the Function of the Total Row – Click in total cell, then click little right 
arrow to right of total cell and select function (e.g. Average). 

Add Formula to a Column – In the next available blank column, click cell and type =, 
click a cell in an adjoining field (eg =[@Commission], and Enter.  

Change Style of Table – Click in table, click Table Design tab, in Table Styles area 
click one of the designs. (Also click on lower right corner of Table and Styles area to 
see more designs.)  

Turn Table Back into a List – Highlight the cells in the table, right click, select Table, 
and Convert to range. It is now a list. To  eliminate the remaining formatting, 
highlight the cells, and Home / Editing, click Clear, and Clear Formats. (Or just select 
the plain white table style on the Design tab.) 

PIVOT TABLES, PIVOT CHARTS  

Pivot Table Click inside an Excel list or table. Select Insert tab and in Tables area, click Pivot 
Table button (or Recommended Pivot Tables), and click OK to accept the range.  A 
new sheet is created with a blank Pivot Table area on the left to receive data, and a 
dialogue box on the right to choose fields whose contents will populate the Pivot 
Table. (You can rename the sheet if you wish.) (Optionally you could have saved into 
one of the current sheets by Selectin Existing Worksheet, and going to and clicking 
in the cell you want to place the Pivot Table in.) 

1. Row (or Column) Labels -- In the dialogue box on the right, drag one or more 
fields of text data up top into the Row Labels area down below (or the Column 
labels area). (E.g. Department and Name) You see the result so far in the Pivot Table 
on the left.  

2. Numeric Values – Then drag fields with numeric data into the Values area below. 
You will now see values for the text fields in the Pivot Table on the left. (e.g. Sales 
and Commissions) (Be sure to add at least one field of numeric data into the Values 
area.)  

Customization To change the arrangement of data, move the fields up and down in the Row (or 
Column) Labels area in the dialogue box on the right (if there is more than one 
there), which will instantly reflect in the Pivot Table on the left. You can do the same 
for any fields in the Values area. You can also move fields from the Rows to Column 
area, and vice versa. Try it out to see different variations! 

To remove fields being used click on the one and drag it to the left and it will 
disappear. To remove all fields from the bottom area at once select Analyze,  
Actions, Clear, Clear All. 

To change the function in the Values area from Sum to something else (e.g. 
Average), click the down arrow next to the sum of X Field in the Values area below, 
click Value Field Settings, click a different function (e.g. Average).  (If you wish you 
can also change the label in the Custom Name area (eg from Average of Sales to just 
Average.) Click OK. 
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To format the values in the Values area, click the down arrow next to the sum of X 
field in the Values area below, click Value Field Settings, click the Number Format 
button, select a number format (e.g. Currency) on the left and click OK. 

Update source data – If you make changes to the original data and want to see it 
update the Pivot Table, then in the Pivot Table/Analyze tab, in the Data area click 
the Refresh button arrow, then Refresh All, and the Pivot Table updates.  

To filter data, drag a field you want to filter by (e.g. Region) from the Pivot Table List 
pane to the Filter area. Then in the Pivot Table itself, at the top, click the down 
arrow that appears next to the filter field (e.g. for Dept), clear the Select All 
checkbox, and select the entries you want to see. (e.g. HR)  

You can also filter by right clicking wherever you see a down arrow in the Pivot 
Table. There you can use various filtering methods, including Value and Label pre-
built filters, etc. 

Also see Timeline and Slicers feature, explained below. 

To show as e.g. % of Grand Total instead of result of a function, drag another 
instance of the X field into the Values area, click the down arrow, click Value Field 
Settings, click Show Values As Tab, select show % of Grand Total from pop-up, and 
click OK. To remove % or similar selections, select No Calculations. You can also see 
% of rows and columns fields. 

To sort data, right-click in a cell of data, select Sort, type of sort (e.g. Sort Largest to 
Smallest), and OK. (You will not be able to sort all data, only those sortable.) You can 
also sort by right clicking wherever you see a down arrow in the Pivot Table. 

To change order of column, click on a column heading, and then when you see 4-
headed arrow, click on the edge of the cell and drag it left or right, before or after 
the column you want. 

To group data, create a pivot tables from a list, and drag  Dept and then Sales into 
Row area. Then right click that column of Sales values and select Group. You  see the 
starting and ending values. Then  enter the Interval value eg $50,000. OK. Now the 
data will be grouped by $50,000 values.  

You can do similar for Dates, but not for Text values.  

To ungroup, click in a grouping cell, right click, and select Ungroup. 

To show/hide subtotals, grand total, click any cell in the Pivot Table, in the Design 
contextual tab, in Layout group, make selections from Subtotals pop-up (eg Show all 
Subtotals at Bottom of the Group). To show/hide Grand Totals, select Design, 
Layout, Grand Totals, and select an item. (eg On for Columns Only) 
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To switch to another Pivot table style, click in Pivot Table, on the Design contextual 
tab, in the PivotTable Styles area, click a Style, or click the More button in the right 
corner to see more styles, and pick one of these. 

To change range of source data, click in Pivot Table, click Analyze tab, in the Data 
area select Change Data Source and Change Data Source.  

-If data has been added and the Pivot Table is based on a list, then you will need to 
modify the range by highlighting the range. 

-If data has been added and your list has been turned into an Excel table, and 
records are added, columns inserted, etc. then the range automatically adjusts. You 
will have to do a Refresh to see in Pivot Table field list if you added a column. 

-If you want to have the range refer to a completely different data source, such as 
another table, then enter the name of the table in the Table/Range area (e.g. Sales).  
(To name a table in the first place, click in the table, click Design tab, in Table Name 
area way on the left enter a name - eg Sales.) 

To collapse or expand a grouping of data, right click the cell that has a “+” or “ 
showing and select Expand/Collapse, and then eg Collapse Entire Field  

To show detail info, double click a Summary calculation (in bold) in the Pivot Table, 
and a new sheet will be created with the detailed data for that segment. 

To create a calculated field, select Pivot Table Tools Analyze, Calculations, fields 
Items and Sets, Calculated Field, enter a name for the custom calculated field (e.g. 
SalesProjection), click a field from the list (e.g. Sales), select Insert Field, in the 
Formula Text Box after e.g. Sales, type in an expression (e.g. *1.5), Select Add, OK. 
Now the calculated field is available in the Field List to be used. Additional Features 

If field list disappears on the right, be sure to click in the Pivot Table data which will 
enable you to see it, or if not click Field List on the Analyze tab in the Show areas. 

To clear all fields from Pivot Table at once (plus action of any timeline or slicer 
filters), select Pivot Table Analyze tab, Actions, Clear, Clear All.   

Slicers, Timeline 
Filters 

Slicers and Timelines are special PivotTable filtering tools.  Slicers work on mostly 
any kind of data, whereas Timelines require dates in the Pivot Table. 
To create a Slicer filter, click anywhere in the Pivot Table, and on the Pivot Table 
Analyze tab in the Filters area click Insert Slicer. In the Insert Slicers dialog box check 
the boxes you want to create slicers for. Click OK. A slicer appears for each table 
header you checked in the Insert Slicers dialog box. To use - in each slicer, click the 
items you want to show in your table. To choose more than one item, hold down 
Ctrl, and then pick the items you want to show. 
-To connect a slicer to more than one PivotTable, go to Slicer Tools, Options, Report 
Connections > check the PivotTables to include, then select OK. 
 

1. To create a Timeline filter, Place the cursor anywhere inside the pivot table and 
then click the Analyze tab on the Ribbon in the Filter area. Click the tab's Insert 
Timeline command. 

2. In the Insert Timelines dialog box, select the date fields for which you want to create 
the timeline. To use, click the arrow next to the time level in the upper right, and 
pick the one you want (e.g. Months). Drag the timeline scroll bar to the time period 

https://support.microsoft.com/en-us/office/calculate-values-in-a-pivottable-11f41417-da80-435c-a5c6-b0185e59da77
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you want to analyze. In the timespan control, click a period tile and drag to include 
additional tiles to select the date range you want. Use the timespan handles to 
adjust the date range on either side. 

3.  
4. To clear Filters, click the filter icon at the top of the slicer or timeline filter. (Or to 

clear all filters at once select Analyze, Actions, Clear, Clear Filters).   

Pivot Charts A PivotChart is a Pivot Table driven chart. 

To create a PivotChart, click inside a list or table, Insert/ Charts area, click the 
PivotChart button, select PivotChart, accept the highlighted area by clicking OK. A 
separate sheet is created with the empty pivot table and pivot chart holding areas 
on the left, and the potential fields on the right. To create a Pivot Chart from an 
existing Pivot Table, click inside Pivot Table and then select Insert/ in Charts area, 
click PivotChart, then PivotChart. 

Manipulate Fields in Pivot Chart Fields area -- Select the Pivot Chart, and add, 
move, or remove fields on the right side of the screen. When the Pivot Chart is 
selected, you see the Pivot Chart Fields List, and you can maneuver fields into the 
Axis/Category, Legend (Series) areas, which roughly correspond to Rows and 
Columns areas when a Pivot Table is selected. 

To change the PivotChart type, click PivotChart, Design contextual tab/ Type group, 
click Change Chart Type, click a type (e.g. Line), and then a subtype. 

To apply a different style to PivotChart, click chart, Design contextual tab / Chart 
Styles group, click the More button (lower right corner), examine the style types, 
and click a Style.  

To filter the PivotChart, click the down arrow for one or more of the field name that 
appears on the PivotChart itself (e.g. Dept), deselect Select All, click one or more 
entries (e.g. two different salespeople), and OK.  

To change the function from Sum to something else, click the Sum of X that 
appears on the PivotChart, select Value Field Settings, click a different function (e.g. 
Average), and OK. 

To change the format number of an axis, click PivotChart, activate the axis, right 
click the values in the axis, click Format Axis, click Number, change the Bounds range 
(e.g. 0 to 1000) and the Major and Minor Units (e.g. 100 and 20). 

If you change the data of the original list/table, and want to see the updated values 
in the PivotChart, select the PivotChart Analyze contextual tab, Data group, click 
Refresh.  

To resize PivotChart, click lower right corner of PivotChart, and when you see the 
double arrow, click and drag up to desired size. 

To move a PivotChart in same sheet, click the PivotChart, and when you see 4-
headed arrow, drag to desired location. To move PivotChart to another sheet, click 
PivotChart, Design/ Location group, click Move Chart, click either New Sheet, name 
the new sheet, and click OK; or select an existing sheet from the Object pop-up list. 

To add or subtract a PivotChart element, click on the PivotChart and click the “+” 
icon to the right of the chart and check or clear any of the elements. Eg depending 
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on the current status of the PivotChart you could select to add an x axis, add a 
legend, and then double click them to change their text.  Advanced Elements Control 
– Click Pivot Chart, click Design tab, click Add Chart Elements, roll over items, and 
select desired change. 

To format parts of a PivotChart, click an area of the PivotChart and make selections 
from the Format Plot area on the right. Eg double click the background of the 
PivotChart and then click the Fill button on the right and choose gradient fill. 

To print a PivotChart, click on it, File/ click Print. If the PivotChart is on its own 
sheet, then you can just print. If the PivotChart is on the same sheet as the data, 
then when you do File/Print, verify Print Selected Chart button is selected, and then 
click Print. 

Trendlines – For each series you can have its own Trendline, even multiple 
Trendline of different types. To create a Trendline select Data series in PivotChart, 
then click “+” to add chart element, select Trendline. Now click the Trendline and 
under Chart Tools tab at top of page select Format. Then click Format Selection on 
the left, and change to the Trendline you want on the right.  

To extend the Trendline to make a projection, make sure Format Trendline dialogue 
box is open on right, click Custom under Trendline Name below, type Forecast in the 
box to right, in the Forward box type 5. Try out the various Trendline types again. 
You see it projected out five years.   

To create a PivotChart template, right-click the PivotChart, and pick Save as 
Template, type an appropriate name, click Save. To use a saved template, in Insert/ 
Charts area, click Recommended, click All Charts at the top, click Templates folder 
on left, and select a template from My Templates (that you created) to base your 
new chart on. To apply a template to an existing PivotChart, select Chart, in Design 
tab, click change Chart Type, click Templates folder on left, and select desired 
template to be applied. 

Create PivotTable 
based on Multiple 
Tables 

(See Excel365 
MultiTablePT file) 

1. Convert Lists to Tables - To create a PivotTable based on Multiple tables, open the 
file with the lists (eg MultiTablePT ), click in each list and convert into a table (Insert, 
Table, Ok) . Then in the upper left of the Table Design tab give the table a name (e.g. 
Customers and hit Enter). Do the same for other tables (e.g. Products, Transactions) 

2. Create Pivot Table - Click in one of the tables, and select Insert/Pivot Table. Check 
the box labeled "Add this data to the Data Model" and press OK.  

Click "All" at the top of the PivotTable Fields window in the upper left to view all of 
the tables. (Excel automatically detects multiple tables, so you won't need to repeat 
these steps for each additional table.) Click to the left of each table to see all of its 
fields. 

3. Relating the Tables -- Create relationships between tables by selecting Pivot Table 
Analyze, Calculations, Relationships. In the Relationships window click New. Pick the 
two tables you want to relate on the left, and the fields from the two tables that 
enable a linking relationship on the right. Do this again for any other two tables you 
want to relate that have a common field type of information. (click New, select two 
tables and common fields, etc.) Click Close when done. 



 29 

4. Using Fields in Pivot Table -  Drop and drag the fields as necessary from among 
the tables in the Pivot Table fields area on the right.  

Note: results you get in the Pivot Table will only be as good as the setup/structure of 
the tables that are used for the underlying data. Normally you try to create a Many 
Table and one or more One Tables. E.g. a customer may appear many times in the 
Customer Name field in the Many Table (eg Transactions), but only once in the One 
Table (Customers). Now when you link the Customer Name of the two tables in the 
relationships window, the ensuing data in the Pivot Table will be accurate. 

Create Live Link from 
External Data Source 

Create a new Excel file/workbook. Select the Data tab/ from Get Eternal Data group, 
click a data source (e.g. From Text or From Access), and select the file; or otherwise 
follow the wizard or other instructions to make the connection.  

Example: Using Access database. You can bring in an Access file that contains one or 
more tables. If the file has multiple tables, it is likely also linked into relationships in 
Access itself. Therefore, when you Get the file, it will also see them linked in the 
Excel sheet it is brought into.  

1. (in Excel 2016 – not 365) 

1. Data, Get External Data, from Access 

2. Navigate to the desired file and click Open. 

3. In Select Table dialogue box check the Enable selection of multiple tables check 
box.  

4. Check the Name checkbox to select all of the tables and then click OK. (Note: we 
are assuming here that the tables have already been related through Access’s 
relationship system.) 

5. In the Import Data dialogue box, in the Select how you want to view this data in 
your workbook section, verify that PivotTable Report is selected. 

6. In the Where do you want to put the data section, verify that Existing workbook is 
selected. Then select OK. 

7. On the Active tab of the PivotTable Fields task pane, drag the fields to desired 
areas as needed. 

 

2. (in Excel 2016 365) 

3. 1. Connect -- Click the Data tab, then in the Get and Transform area, click Get Data > 
From Database > From Microsoft Access Database. In the Import Data dialog box, 
browse for file to import, and then click Import. In Navigator dialogue box click 
Select Multiple items check box, and then click the checkbox for each of the tables 
you want to import.  Then click Load. The imported tables are listed on the right side 
of the screen in the Query and Connections screen. 

4. 2. Relationships- Then as necessary create a relationship between the tables by 
clicking the Data tab and in the Data Tools area click Relationships. Then link the 
various tables together by selecting the name of the table on the left, and the 
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common linking field on the right. (If in Access they were already related, then they 
will automatically be related in the Excel file. Then Click Close.) 

5. 3. Create Pivot Table -Then select Insert/ Pivot Table. Make sure “Use an External 
Data source” is selected. Click Choose Connection. Click Tables at top. Select one of 
the tables. Click  Open and then OK. 

6. Click All at top of the Pivot Table Fields screen on the right. Now you should see all 
of the tables listed with their fields. Now add fields as necessary into the Pivot table. 

GetPivotData 
function 

GetPivotData function:  (field name, field location in PT,, filter field, item in field) 
Example 1   =GETPIVOTDATA("Sales",B3)   (shows Sales total) 
Example 2   =GETPIVOTDATA("Sales",B3, "Dept","HR") (shows Dept/ HR Sales total) 

Power Pivot, Query, 
View;  

Beyond Pivot Tables, including those based on multi-table, as well as other Excel 
features are Power Pivot, Power Query, and Power View. Here is a web page that 
explains each with videos. 
https://theexcelclub.com/excel-power-tools-the-future-of-excel/ 

POWER BI 
Visualization and 
Dashboards 

The future of Excel goes beyond even the three separate tools – Power Pivot, 
Query, and View – into one cohesive tool called “Power BI”. With the desktop 
version of Power BI you launch as a separate app, import Excel and other data 
source content (SQL, Access, web, etc.), create relationships among tables, and 
most importantly create dynamic visualizations and dashboards that others can see 
and manipulate over the web.  

We recommend the book ‘Power BI Business Intelligence Clinic, Create and Learn’ 
by Roger F. Silva (in print or electronic Kindle versions) for a great, easy to use 
tutorial on the Desktop version of Power BI, including utilization of imported Excel 
data: https://www.amazon.com/Power-BI-Business-Intelligence-Clinic-
ebook/dp/B07J3DLBXK 

INPUT CONTROL 

Data Validation 
(Delimit What Data 
Users Can Enter into 
Cells.) 

Data Validation Basic Example -- Select a range of cells, Data / Data Tools group, 
click Data Validation. Then Data Validation. In the Allow list, you could e.g. select 
Whole Numbers; in the Data list, click less than or equal to, in Maximum enter a 
value (e.g. 20000), clear Ignore blank check box. Click the Input Message tab, enter a 
title, and enter the input message, e.g. “enter a value between 0 and 20,000”. Click 
the Alert tab, in the Style list click Stop; in the Title box type e.g. “Error”, and then 
click OK. Try out the data validation on the originally selected range of cells. Note: 
you can copy/paste the validation for any cell into other cells (so long as you haven’t 
entered any data into any of the cells.)    

--See Any Invalid Data – Eg you entered data in a cell before setting validation that 
is at odds with the validation you later set. (You had earlier entered 20000, but the 
validation is set to 10,000.) To see invalid data, Data tab /Data Tools group, click 
Data Validation arrow, and in the list click Circle Invalid Data. If you wish, you can 
change the value(s). To clear the circles, in the Data Validation list, click Clear 
Validation Circles.    

Note: Only “Stop” prevents invalid data from being entered. Eg “Warning” warns, 
yet still allows. 

https://theexcelclub.com/excel-power-tools-the-future-of-excel/
https://www.amazon.com/Power-BI-Business-Intelligence-Clinic-ebook/dp/B07J3DLBXK
https://www.amazon.com/Power-BI-Business-Intelligence-Clinic-ebook/dp/B07J3DLBXK


 31 

--To clear validation, highlight the cells, and on Home tab select Clear All.  

Data Validation Pop-up List Example – enter some data (e.g. North, East South, 
West in cells down.) Then highlight a blank range. Data/Validation, select List, click 
in the Source area and highlight the range of the four directions, optionally enter an 
Input and Error message, and then click OK. 

WHAT IF ANALYSIS 

Scenario Manager 
(Save Different What-
If Scenarios/Values of 
the Same Range of 
Data) 

For example, you want to try different scenarios for the range of cells G5 and G6 
which have sales and profits amounts you want to experiment with and change. (By 
doing so, many other cells with formulas in them will recalculate.) 

Highlight a starting range of cells of data you are going to have to change (e.g. G5 
through G6, but not any cell with a formula). Then Data/ Forecast group, click What-
If Analysis, then click Scenario Manager. Click Add. Enter the Scenario Name (e.g. 
“Original Status”). Click OK, OK, then Close. To create the next scenario, change the 
data of the original range (e.g. in G5 and G6 as you want; say to increase their values 
each by 10%). Then Data/ Data Tools group, click What-If Analysis, and then click 
Scenario Manager. Click Add. Enter the Scenario Name (e.g. “10% Increase”). Click 
OK, OK, then Close. Add any more scenarios as desired. Save the file. 

To switch amongst the scenarios, Data/ Data Tools group, click What-If Analysis, and 
then click Scenario Manager. Now click one of the preexisting scenarios you created, 
and click Show at the bottom. The data recalculates to that scenario. 

Data Tables 
(see Multiple Possible 
Outcomes at Once) 

You can use Data Table to see a number of different outcomes at once.   

Open the Sample Excel2016 file, and click What If Forecast Sheet. We want to see 
the sales results for each percentage increase.  

To do that Highlight cells B14 through C23. Select Data/Forecast/What If 
Analysis/Data Table. In the Data Table dialogue box, in the Column cell field (since 
the cell is in a column), select cell B10. (this is the variable cell.) Click OK. The 
projected change is shown for each percentage. 

Excel uses an array formula to generate the results. 

 

Here’s another example (with both single and multiple variables: 

http://www.excel-easy.com/examples/data-tables.html 

Goal Seek, Solver  Goal Seek - It is to find a solution not based on a calculation, but what value you 
want that calculation to be changed to. Eg if the results of a calculation is 63%, and 
you want it to be 66.67%. This is achieved by allowing other cells that determine the 
calculation to change. 

Example: Click the cell you want to increase the value of. This is called the “Set cell”. 
Eg click J6. Then from the Data tab, select the What if Analysis button and then Goal 
Seek. J6 is selected in Set Cell area. 

-In the Goal Seek dialog, enter the new “what if” amount in the To value text box. In 
this example, we’re asking Excel to replace the contents of cell J6 which is 63.90% 

http://www.excel-easy.com/examples/data-tables.html
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with 66.67%. This is the percentage needed to win the election. So enter 66.67% (be 
sure to include the percentage sign.) 

-We also need to tell Excel which cell to change to accomplish the goal. Since we 
want to alter the quantity of YES votes to achieve the goal, we’ll click I6.  

Click OK. Excel will overwrite the previous cell values with the new one. If you wish 
to accept the new value, click OK.  

Solver – It is a more complex version of Goal Seek. Eg you want to maximize profits, 
by allowing one or more of the cells that make up the total to adjust. In addition, 
you can delimit what changes can occur to cells to produce the final outcome. These 
are called “Constraints.”   

Solver is an add-in that you need to install in Excel 2016. 

To install Solver, click File/Options/Add-Ins/Excel Add-ins, Go, select Solver, OK. 
Solver now appears at the end of the Data tab.  

To use Solver, click on it in the Data tab. Then select Reset All to clear previous info. 
-For the Set Objective, click in the cell that you want to maximize the value for. (e.g. 
cell $k$18).  Make sure Max is selected as the function (indicating this is the value 
we want maximize the Set Objective cell.) 
-Now we indicate what can vary to obtain the maximum for the Set Objective cell. 
Specify the changing cells in the By Changing Variable Cells field. Eg the changing 
cells are I15:i17.  

-Now we indicate any constraints that would delimit what is possible. To add a 
constraint, click the Add button. The Add Constraint dialog box appears. To set the 
first constraint (eg total production capacity is 300 units), enter (e.g.) I18 as the Cell 
Reference, choose equal (=) from the drop-down list of operators, and enter 300 as 
the Constraint value. Then Click OK. You return to Solver dialogue box. 

-To set the second constraint, click Add and enter (e.g.) set as I15 >= 40), and then 
OK. Add additional constraints as needed Eg set I16 >=50, and then I17<=40. Then 
click OK.  

-In the Solver dialogue box, (if necessary) select Simplex LP, and then click Solve.  

(for more Solver info, Control-click here: 
http://www.exceldemy.com/a-simple-solver-example-in-excel 

To uninstall Solver, click File/Options/Excel Add-ins, Go, deselect Solver, OK. Solver 
is removed from the Data tab.   

Forecast Sheet  
(project future results 
based on current data 
into Chart) New for 
2016! 

To create a Forecast sheet, open the Excel365 Sample file and click the What If 
Forecast tab. Then highlite the headings and data. Eg e2 through f14. Click the 
Forecast Sheet button in the Forecast button group on the Data tab to open the 
Create Forecast Worksheet dialog box.  You see the logical projection, plus some 

variation above or below it.  

To display the forecast as either a line chart or column chart, choose either the 
“Create a line chart” or the “Create a column chart” button in the upper-right 
corner of the dialog box. 

http://www.exceldemy.com/a-simple-solver-example-in-excel
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To set the end date/time or ending value and set how far out the forecast should 
be projected, use the “Forecast End” drop-downs or spinner box below the chart. 

To set additional, advanced forecast options, click the “Options” arrow or link at 

the bottom of the dialog box to expand that section, if needed. 

To select a different forecast start date, use the “Forecast Start” drop-downs or 

spinner box to set the start date/time or starting value for the forecast. 

To show or hide the confidence interval in the forecast, check or uncheck the 

“Confidence Interval” checkbox. If shown, the default confidence level of “95%” can 

be changed by using the adjacent spinner box or by typing a new percentage to use 

into the box. (This indicates that 95 out of a 100 times, the future values will lie 

within the indicated spread. If 50%, then 50 out of a 100 times the spread will lie 

within the spread shown.  

To choose how to determine seasonal intervals, select an option button under 

“Seasonality.” The default option is “Detect Automatically.” This will adjust the 

results based on seasonal changes it detects. 

To manually set seasonality intervals, select the “Set Manually” option button and 

enter the seasonal value into the adjacent field. In the “Timeline Range” field, you 

should see the range of timeline values. These are the time values that correspond 

to the data values shown in the “Values Range” field. The “Values Range” field 

contains the data values for the timeline values. 

To fill-in missing data points with zeros, use the “Fill Missing Points Using” drop-

down to select “Zeros.” 

To fill-in the value of missing points with the weighted average of neighboring 

points, use the “Fill Missing Points Using” drop-down to select the default value of 

“Interpolation.” 

To use a function other than AVERAGE on values with the same date/time stamp 

if your data series contains multiple values with the same date/time stamp, select 

the function to use from the “Aggregate Duplicates Using” drop-down. 

To include forecast statistics on a new sheet, check the “Include forecast statistics” 

checkbox. 

To create the forecast table itself, click “Create.” A table and chart are created on a new 

sheet, with the original and forecast info. The forecast sheet contains the selected data 

series, the forecasted values, and the upper and lower confidence bounds, if selected, in a 

table on the sheet.  

To change the values shown in the forecast chart, if desired, edit the table’s values or 

formulas. 

Additional info: 

https://support.office.com/en-us/article/Create-a-forecast-in-Excel-2016-for-Windows-

22c500da-6da7-45e5-bfdc-60a7062329fd 

(Chart Trendline – Also for forecasting see Charts section of this doc, and the part on how to 

build a trendline in the chart.) 

OTHER DATA HANDLING 

https://support.office.com/en-us/article/Create-a-forecast-in-Excel-2016-for-Windows-22c500da-6da7-45e5-bfdc-60a7062329fd
https://support.office.com/en-us/article/Create-a-forecast-in-Excel-2016-for-Windows-22c500da-6da7-45e5-bfdc-60a7062329fd
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Data Consolidation  This is best done where the ranges in the various files have the same essential 
layout of data, but different content, such as consolidating budget totals from 10 
different individuals. (Note that by default, the consolidation uses labels that appear 
at the top of the columns of data. 

From different sheets – Create a new sheet and name it Consolidation. Enter some 
headings, eg Sales and Amount, then select the heading and blank range of cells 
under it (say two rows down) where you want the consolidation to take place.  Then 
in Data/ Data Tools groups, click Consolidation. Click the red Collapse/Expand 
button that enables you to select a range, and click the desired sheet and then 
select the desired range of data including the headings. Then close the 
Collapse/Expand button, and click Add. Be sure to clear the Reference info. Now do 
the same for a second sheet and its range, and click Add. Click OK, and a 
consolidation of the data is created on the Consolidation sheet.  

(You have the option of creating links, which is advised. Note that the headings at the top 
are the default basis for pulling the data (below it) for each sheet. Then click OK. The 
consolidated data is put into starting area.)  

Outline of Consolidation -- Also notice that after the consolidation (with links!) occurs, 
outline “+” signs can be seen on the left side of the screen, which is essentially hiding the 
details data. If you click one of the “+ items you will see the detail records for that part of 
the consolidation. You can then collapse it down by clicking the “-“ sign that appear. 

To remove the outline, on the Data tab, in the Outline area, click Ungroup, Clear 
Outline. 

From different files - Create a file and name it (e.g. Consolidation). Then in Data/ 
Data Tools groups, click Consolidation. Click the Collapse Dialog button. Then switch 
to another File window with View/ Window group, and select file. Then select the 
range to consolidate, click the Expand Dialogue button, and Click Add. Now follow 
the same procedures beginning with collapsing the dialogue box to enter another 
range; and so forth for the number of entries you want. When done click OK.  
 
Altering Links - When linking to other files in the data consolidation, you  can see, 
adjust, redirect, or break links to another file by clicking in any cell with the data 
consolidation result, and then selecting  Data/ Queries & Connections group, and 
then clicking Edit Links.   

Data Types 
(Stocks and Geography) 

(office 365 only) 

1. Type some text in cells. If you want stock information, type a ticker symbol, 
company name, or fund name (eg Kellogg Co, Apple) into each cell. If you want 
geographic data, type a country (eg United States, India), province, territory, or city 
name into each cell. 

2. Then select the cells. 

3. (Although it's not required, we recommend creating an Excel table. Later on, this will make extracting 
online information easier. To create a table, go to Insert > Table.) 

4. With the cells still selected, go to the Data tab, and then click either Stocks or 
Geography. 
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5. If Excel finds a match between the text in the cells, and our online sources, it will 
convert your text to either the Stocks data type or Geography data type. You'll know 
they're converted if they have this icon for stocks: and this icon for geography:  

6. Select one or more cells with the data type, and the Insert Data button will 
appear. Click that button, and then click a field name to extract more information. 
For example, for stocks you might pick 52-week high and for Geography you might 
pick GDP. 

7. Click the Insert Data button again to add more fields. (If you're using a table, here's a tip: 

Type a field name in the header row. For example, type Change in the header row for stocks, and the 
change in price column will appear.) 

AUTOMATION WITH MACROS 

Intro Show the Developer toolbar – To use macros in earnest first bring up the Developer 
tab. To do that select File, Options, Customize Ribbon, click Developer checkbox on 
the right among the Main tabs, OK. 

Record, Run Macro  Record Macro – If necessarily have insertion point in a sheet in any Excel file, click 
the Developer tab and then in the Code Area, click Record Macro.  

Macro Name --Enter a name for the macro.  

Shortcut Key -- (Optionally) enter add a shortcut keystroke (e.g. enter B to make it 
Control, shift, B), 

Store Macro In -- Accept the default store in file type of Personal Macro Workbook.  

(explanation) By default when you create a new macro, Excel saves it (and any other 
you create) in a hidden Personal Macro Workbook file, stored on your computer as 
Personal.xlsb. You can thereby run this and any other macro in any Excel file, as the 
Personal.xlsb will always be available in the background.  

(You can also save your macro in the This Workbook location, which only allows you 
to run the recorded macro in the current file.) 

Click OK. 

Record Steps – Each command you do in Excel is now being recorded. (E.g. in B2 
enter Budget Year: 20xx, then enter Qtr1 in B# and drag auto fill to right until it 
creates Qtr1, Qtr3, Qtr4. Then in A4   enter Staffer 1, hit Enter and enter Staffer 2, 
etc. through Staffer4. Create a border around the data, make the interior cells with 
a light orange background, etc. 

Stop Recording and Save File -- To stop the recording, click the Developer tab and 
click Stop Recording. Then save the file as “Macros” or a different name. 

Run Macro – Open regular Excel file/workbook file you want you want to run the 
macro, if necessary, select a desired sheet, click an insertion point (e.g. b2), select 
Developer tab, click Macros, select a macro, and click the Run button.  

(Note: Release Security: you may not be able to run the macro unless the security is 
released. To release security for running a macro in a file, click Macro Security 
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button in the Code area of the Developer tab. Then make sure Enable all macros … 
is selected as well as Trust Access … is selected.) 

Relative Macro – Normally macros are built with absolute reference. This is the 
default. That means when you run the macro it will apply it to the same locations in 
the sheet as it was created in the macro file. If you want a macro applied to 
different areas, you need to change it to relative reference. Eg if you entered the 
contents and then a formula into cells A1:A6, then when you run it, it will enter 
those same entries in the current sheet in A1:A6. That is absolute reference which is 
the default. However, if you want to see those cells values entered in a different 
range in the sheet, then you would have turned on Relative Reference when 
recording the macro in the first place.  

To record a relative macro, select Developer, then Record Macro, etc. OK. Then 
click the Use Relative Reference button (it will turn green indicating it is on), do the 
keystrokes you want to capture, Stop Recording. Save. Now you can switch to the 
file you want to apply it to, have an insertion point or range of cells selected and run 
the macro with Developer, Macros, select the macro you want etc. etc. 

Modify Macros Edit Macro – Open any Excel file. Get an insertion point (eg cell B2). Then click 
Developer tab, in the Code area click the Macros button, (make sure Macros in 
Personal.xlbs is selected). click an available macro, and then click Edit button. (Note: 
to view code the, the Personal.xlbs must be unhidden. To do that, click View tab and 
select Unhide.  

Make changes as necessary. E.g. remove the two lines of code related to c4 by 
highlighting and right clicking and selecting Cut, and then below that change the 
range for the background color to c2:c3. In Visual Basic Editor, on standard toolbar, 
and click Save button. Click Close button to exit the VB Editor. When run, the macro 
will take the appropriate new action. Before using macros again be sure to rehide 
the Personal Macro sheet by activating that file , and then selecting View/Hide.  

Note: Alternatively, you can simply rerecord the macro if there are too many 
changes to be made. You might consider including fewer steps when recording the 
macro, making sure it works ok, then record another macro that now includes more 
of the features you wanted. 

(more advanced) Step through Macro – Open any Excel file.  Then Developer tab, in 
the Code area click the Macros button, make sure Macros in PERSONAL.XLBS is 
selected, click an available macro, and then click Step Into button. Hit F8 repeatedly 
to step through the macro commands (while executing it). When done select 
File/Close and Return to Microsoft Excel. 

Delete Macro – Select the Macros button on the Code area of the developer ribbon, 
select desired macro to delete, and then click Delete button on the right. If 
prompted, you will need to first unhide the Personal workbook by selecting View, 
Window, Unhide, and select Personal file. Then you can delete the macro. (After 
deleting the macro, be sure to Hide the Personal file with View, Window, Hide so 
you can record additional macros using the Personal Macro Workbook.) 

Note! If all macros disappear from list, then exit and restart Excel, and they should 
reappear. 
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Access Macros from 
Other Locations 

Add View Macros List to QA Toolbar – On Quick Access Toolbar, click down arrow, 
and select More Commands from the Choose commands from area. In the 
commands list, click View Macros. Click Add. OK. 

Run Individual Macro from QA Toolbar – On Quick Access Toolbar, right click and 
select Customize Quick Access Toolbar button. Click Macros from the pop-up list. In 
the commands list, click the name of an existing macro. Click Add in the middle of 
the page. (Optionally, click the Modify button below and assign the macro to an 
icon.) Click OK. You can now run that individual macro from the QA Toolbar. 

Create Button Sheet for Macro – From Developer tab, in Controls Area, select 
Insert, select the (first) button icon, click and draw on sheet, select Macro to use, 
rename the button, click outside it, and try out macro. 

Place Macro on Ribbon Tab – On right side of Quick Access toolbar select down 
arrow, choose More Commands. Select Customize Ribbon on the left, expand and 
then click on Developer on the right. Click New Group in lower right and click Add. 
Rename the group (eg Heading Macro). Select Macros on upper left. Click a macro 
and then click Add. Click Ok. The button appears on (e.g.) the Developer tab. 

-Note: you can send your .xlsm file to others, were they can run these macros on 
their own files. 

Create, View Macro 
(simple approach) 

The simplest approach to creating a macro is to simply save the macro in the 
current file, which means you will only be able to run it inside this file, not any 
other. To do that when you record the macro you select “This Workbook” instead of 
Personal Macro Workbook. (There is no special .xlsb file created as described 
above.)  To see an example video of this local saving of the macro, yet with a more 
sophisticated example of a macro yet with massive reformatting of data, click here 

INTEGRATING WITH OTHER APPLICATIONS 

Copy Excel Info to 
PowerPoint or Word 

In a workbook file, select an Excel cells, a table, chart, or pivot table, right click and 
select Copy. Then open a slide in PowerPoint or have an insertion point in Word, 
right click and make a Paste Option selection. To create a dynamic link, so that if the 
Excel data changes it will change in PowerPoint or Word, select Keep Source 
Formatting and Link. (In PowerPoint, you may need to re-copy from Excel data 
source, and then select Paste/Past Options in the clipboard area of the Home tab to 
and work your way to the Paste Link choice in the dialogue box.) 

COLLABORATING WITH OTHERS 

Collaborating with 
Others in Making 
Changes in Document 

“Co-Authoring” requires Excel 2016 or later or Excel 365, including OneDrive 
services. To use, make sure OneDrive is installed and functioning properly. Here’s a 
short video of the process. Here is a more detailed explanation for Sharing an Excel 
file. 

https://www.youtube.com/watch?v=33Ej8DPsdvA
https://support.office.com/en-us/article/collaborate-on-excel-workbooks-at-the-same-time-with-co-authoring-7152aa8b-b791-414c-a3bb-3024e46fb104
https://www.lifewire.com/how-to-share-an-excel-file-4691732
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Add Comments and 
Notes 

Introduction - Excel now allows for  threaded, cross-user conversations called 
Comments. Plus it also allows for  Notes. (The old Comments system has been 
renamed Notes, and the new conversation system is called Comments.) 

Comments - Comments are for threaded Conversation between you and others 
whom you have shared a file with.  

Once the file is shared (see above), right click a cell and select New Comment, type 
comment, and click Post icon. Another person whom you have shared the  file with 
can now click in the reply area and enter their comment.  

To edit the comment hover over the cell with the comment, wait a second, and 
select Edit. To delete a comment right click cell and select Delete Comment.  To 
either resolve (end) or delete the thread hover over a conversation, click ellipse in 
upper right, and either select resolve or delete. 

To show all comments, select the Review tab, in Comments area select Show 
Comments. They all show up on the side pane. 

Notes – Notes are for Annotation. Right click a cell and select New Note. Enter your 
note and click outside the cell. For more actions right click the cell where you can 
edit, delete, or show or hide the note..     

MAPPING 

3D Maps  New! The popular 3D geospatial visualization tool is now built into Excel 2016. It works 
somewhat like a Pivot Table and Pivot Chart. The visualization is based on the data 
in an Excel table. The dataset needs to contain geographical locations, like city, 
states, regions, countries, etc. 

Example: Open Excel file 3D Maps - Develetech Sales. Select Map Data tab. Make 
sure a cell in the table is selected. Insert/3D Maps/Open 3D Map, click Enable. The 
3D Maps subsystem opens.  

-On the right in the Layers pane for Layer 1, in the Data area, make sure State is 
selected as the location. (This is sort of the Grouping field, i.e. we want to group the 
data by State.) 

--Now we want to see the Total Sales for each State. In the Layer pane, in the Height 
section, select Add Field, and choose Total Sales.  

-Try out each of the visualizations by clicking the icons under Data. This shows the 
state data visually in different ways. Then leave it as the last icon selected (Region) 

-Also click the arrows in the lower right of the graphic to go up, down, left right, 
zoom in and out, etc. 

Now we want to see a video visualization over time. To do that we need to activate 
a time sequence.  

-In the Layer Pane, in the Time section, select Add Field, and choose Month. 

-You can shrink the size of the Layer legend that appears. You can also Show and 
Hide the field list. 

-To run the video visualization, click the Play button in the bottom middle of the 
screen. Each region appears with its corresponding states over months at a time. 

Another example: Video 1   

https://www.youtube.com/watch?v=P--qP4mfxEg
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Map Chart Create Map Chart - Highlight data that includes geographical information, like 
Country/Region, State/Province, County, or Postal Code. Eg includes Country 
heading with  names under it, with corresponding Amount heading with amounts 
under it. Then click Insert > Charts > Recommended Charts, or Insert > Charts > 
Maps, then select the map chart. Depending on your data, Excel will preview either 
a value or category map. 

Formatting Map chart - Once your map has been created you can easily adjust its 
design. Just click on the Map, then choose from the Design or Format tabs in the 
Chart Tools ribbon tab. You can also Right-Click on the chart and select from the 
menu options there, or double-click the chart to launch the Format Object Task 
Pane, which will appear on the right-hand side of the Excel window. This will also 
expose the Map chart specific Series options. 

MISCELLANEOUS 

Configuring Excel 
Options 

Select File, Options, (e.g.) General tab, and in the When creating new workbook 
section, change setting in the include this many sheets spin box from 1 to 5. Or- 

(e.g.) select the Advanced tab, scroll down to the Display section, and set the value 
in the Show this number of Recent Workbooks to 10.  

Modify Excel 
Interface Tabs 

Change Background Scheme of Excel -- File/Options/General, (Personalize Your 
Copy of Excel area) Office Theme, e.g. select Dark Gray, OK. (Note: all Office 2016 
apps could be similarly affected by making this change in Excel). 

Add Group and Commands to Ribbon -- File/Options/ click Customize Ribbon on 
left, etc. Select Home tab on upper right. Click New Group down below, Right click 
and Rename New Group to Misc. Make sure new group is selected. Then add 
commands to that group  by selecting items  on left (eg email) and adding to the 
right. Then OK.   

Create Hyperlinks  Create Hyperlink to Another File – click in a cell of a sheet, Insert/ Links group, click 
Link, then Insert Link. Navigate to an Excel file (or other file), click it, and click OK. 
Try it out by clicking on the now underline link. 

To Edit, Remove Hyperlink – Right click hyperlink in cell, and select Remove 
Hyperlink. You ca also remove the unlinked text. 

Create Hyperlink to a Named Range in Current Workbook – Right click a cell, click 
Link button. In the link to pane click Place in This  Document on the far left, click the 
Sheet name or named range ), and click OK. Try it out. 

Create Hyperlink to Web Page -- Go to a web page (eg Google.com) and copy the 
URL. Enter “See Google” into a cell and hit enter key. Click the cell, right click and 
select Link. Click Existing File or Web Page on the left. Right click and select Paste. 
Click OK. Try it out. 

Excel and the Web Save File to Web – File/ Save As, click as Web Page as the type, enter the name, 
click Save, and click Yes. To save part of a file to the web, e.g. a Pivot Table, File/ 
Save As, click as Web Page as the type, click Publish, in the Choose list select Items 
on SheetX, in the Items to publish list click (e.g.) PivotTable or a named range, 
(optionally) select the Autopublish … check box, and click Publish. 
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Import Data from the Web -- Select a web page, and copy the URL. Navigate to the 
Data tab and find the New Query tool. Inside the New Query tool, find the “From 
Other Sources” and select “From Web”. Next paste the link for the site that contains 
your desired data., click OK, and the Connect. Once the query has had time to 
process the site, you’ll be provided with a list of query-ready resources. Select the 
table you want from the page and then select edit. Clean up the imported data as 
necessary. Then click Close and Load. (Note if the data on the web page changes, 
you can right click the data in Excel and select Refresh, and the data in Excel will 
update.) 

Save File to PDF File, Export, click Create PDF, click Options, make a choice there (eg Active Sheet or 
Entire Workbook), rename if necessary, and Save. Open the file from Desktop or 
wherever saved to view. 

Flash Fill In a list, type in the first item to right of list next to first entry as you would like it. Eg 
HR-Joe. Then hit Enter to go to next cell. Then do Control E, and the data will be 
entered into the remaining corresponding cells relative to what it sees in the list 
(HR-Bill, HR-Mary, HR-Sue).  

Tip: Sometimes you need to put two entries in (i.e. in two cells) to get a pattern for 
Flash Fill to work. Eg if you want to derive the last four letters from content of list of 
city names. Eg you have Los Angeles and San Francisco. You type in eles next to Los 
Angeles and isco next to San Francisco. Then highlite both and hit Control E. 

Analyze Data AI You can get AI feedback of new, creative ways of presenting your data set; whether 
as rearrangements of  data and formulas, charts, lists, pivot tables, etc..  

To use, click anywhere inside an area with data in it, and then on the Home tab click 
the Analyze Data button way over on the right (if available). You will see one or 
more suggested outcomes,  as well as natural language capability, when you can ask 
the system questions. Click + Insert X at the bottom of an entry which will copy it 
onto another sheet. (You can then move it to wherever desired.) 

New Features for 
Excel 2019/Excel 365 

https://support.microsoft.com/en-us/office/what-s-new-in-excel-2019-for-windows-

5a201203-1155-4055-82a5-82bf0994631f 
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